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 Introduction 
HydraMotion is a simulation software package that provides an accurate working simulation of hydraulic 
devices and circuits. It enables students to study and understand the principles of hydraulics. 

As a design tool, HydraMotion allows students to create, operate and observe a model circuit. The 
circuit can be printed, altered and improved as needed. 

HydraMotion can be used in conjunction with the HydraFlex work panel, on which an actual circuit with 
working components can be assembled and operated. 
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 Installation and Activation 

2.1. SYSTEM REQUIREMENTS 

• Hardware requirements: 
▪ Pentium 4 Dual Core with 3 GHz processor or higher 

▪ At least 512 MB RAM (1 GB for Vista) 

▪ A hard drive with at least 100 MB of free disk space 

▪ A VGA or better graphics display, minimum 256 colors 

▪ A mouse or other pointing device 

▪ Separate RS232 ports on the PC-for each hardware device which uses an RS232 port (or 

USB ports with RS232 – USB adapter) 

• Software requirements: 
▪ Windows 8.1 Pro or higher (64-bit only) 

▪ Windows 10 Pro or higher (64-bit only) 
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2.2. INSTALLING THE SOFTWARE 

The section below describes how to install the HydraMotion software. For licensing help, see the 
Intelitek Software Licensing Guide. 

 Note: HydraMotion software does not support Network Licensing. 

 To install the software, do the following: 

1. Start Windows. 

2. Close any open applications before you begin the installation. If you are about to reinstall the 

software or install a newer version to an existing HydraMotion directory, it is recommended that 

you backup any existing user-created files before you begin the installation. It is also 

recommended that you remove the previous HydraMotion installation by means of the Uninstall 

utility included with the software. 

3. Run HydraMotionSetup.exe. The welcome screen is shown.  
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4. Click Next. The License Agreement is shown. 

 

5. Check I accept and click Next. The Setup Type screen is shown. 
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6. Select the Controller Type and click Next. The Interface Language is screen is shown. 

 

7. Choose your desired language and click Next. The Choose Destination Location screen is shown. 

By default, the software is installed to the folder C:\Intelitek\HydraMotion. During the 

installation process you have the option to change this. It is not recommended that you do so. 
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8. Click Next. The Select Program Folder screen is shown. 

 

9. Click Next. The Setup Status screen is shown. When the status bar completes the InstallShield 

Wizard Complete screen is shown. 
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10. Click Finish to exit the InstallShield Wizard. 

When the installation is complete, the HydraMotion icons will appear. 

 

 

2.3. UNINSTALLING THE SOFTWARE 

This section describes how to uninstall your software. Before you uninstall the software, you should 
backup any existing user-created program and position files.  

 
 Note: If required, before you uninstall the software you can return your license to Intelitek (and 

retrieve it later).  For further details refer to the Intelitek Software Licensing Guide. 

 HydraMotion software does not support Network Licensing. 

To uninstall HydraMotion, do the following: 

1. From your windows Start menu, select All Programs | HydraMotion A popup menu is displayed. 

 

2. Select Uninstall HydraMotion to remove your HydraMotion software components and follow 

the instructions that appear on the screen.   

2.4. ACTIVATING THE SOFTWARE 

To start HydraMotion, do the following: 

1. If you will be using HydraMotion with a HydraFlex panel, make sure that all hardware has been 

properly set up and connected according to the installation procedures detailed in the user 

manuals. 

2. Turn on the computer and all other connected hardware. 
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3. From your Windows Start menu, select All Programs | HydraMotion. The following popup menu 

is displayed.  

 

4. Select HydraMotion. The HydraMotion application window is displayed. 

 

2.5. QUITTING THE SOFTWARE 

To quit HydraMotion, use any of the standard Windows methods for closing a program: 

1. In HydraMotion, select File | Exit. 

2. Double Click the Control-Menu box in the Title Bar. 
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 Overview 

3.1. THE HYDRAMOTION WINDOW 

The elements of the main HydraMotion window are shown in the following diagram: 

 

 

Title Bar Contains the usual Windows controls for sizing and closing 
the application screen as well as an additional option 
enabling you to display the interface on top at all times. 

Menu Bar Contains menus with HydraMotion commands. Some 
commands are accessible from the tool bar (buttons), while 
some are accessible only in the menus. 

Tool Bar Contain buttons that represent the most frequently used 
functions and commands. Button availability varies 
according to the currently active screen or mode, or the 
selected component. 

Drawing Area Screen area used for designing and displaying circuits 

 

Drawing Window  

Status Bar 

Menu Bar 

Tool Bar 

Title Bar 
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Status Bar Displays, at the bottom of the screen, information 
regarding the HydraMotion software, modes of operation, 
current activity, and so on. When you position the mouse 
over an icon, a description of the icon appears in the status 
bar. 

3.2. FILE MENU 

 

The File menu contains the usual Windows functions which allow you to load, save 
and print files containing hydraulic circuit diagrams and connections, and to exit 
the software. 

Only one file can be opened and edited at a time; however you may 

open a second window to create and edit a second file. 

 New  [Ctrl]+N Opens a new, untitled file. 

 
Open  [Ctrl]+O Opens an existing file. 

 
Save  [Ctrl]+S Saves the currently active file. 

 Save As... Saves the currently active file under a new file 
name. 

 
Print  [Ctrl]+P Prints the currently active file. 

 Delete... Deletes a previously saved file. 

 Exit Quits HydraMotion. 

If changes have been made to a file, but not yet 
saved, a warning message will be displayed. 

For more information on file management, see Chapter 8. 
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3.3. EDIT MENU 

 

The Edit menu contains usual Windows functions found in most drawing 
programs. These allow you to edit cross section and schematic diagrams. 

 Copy          [Ctrl]+C Copies a selected component to the clipboard 
as a regular drawing object. It can then be 
pasted into any other program. 

 
Duplicate Makes a copy of the selected component. 

 
Rotate Right        F7 Rotates the selected component 90° to the 

right. 

 
Rotate Left Rotates the selected component 90° to the left. 

 
Mirror                 F8 Reverses the selected component horizontally, 

so the left becomes right and vice-versa. 

 
Flip                     F9 Reverses the selected component vertically, so 

the top becomes the bottom and vice-versa. 

 
Delete             [Del] Deletes the selected component. 

 
Parameters           ! Sets values for selected components. This 

option is only available for those components 
which have variable parameters. 

For more information on editing functions see Chapter 4. 

3.4. VIEW MENU 

 

The view menu contains the commands for the viewing modes available 
in HydraMotion. 
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Cross Section Displays a cross section view of each 

component. 

 
Schematic Displays the components in standard schematic 

form. 

 
Ladder Diagram Opens a schematic control flow chart for 

electro-hydraulic circuits. 
 

  
Parameter Diagram Opens a dialog to monitor pressure and flow 

during circuit operation. 

 
Zoom In Magnifies the current view. 

 
Zoom Out  [Ctrl]+Z Returns the view to normal. 

For more information on viewing see Chapter 6. 

3.5. COMPONENTS MENU 

 

The Components menu contains the commands for selecting the 
HydraMotion Component List and Library. 

 
List           [Ctrl]+F2 Opens a list of the HydraMotion components 

organized by category. 

 
Library               F2 Opens a graphic library of the HydraMotion 

components and devices. 

For more information on selecting components see Chapter 4. 

3.6. CONNECTIONS MENU 

 

The Connections menu contains the commands for connecting 
components in HydraMotion. 

 
Connect Components   
F5 

Selects the Connect Components view. 

 
Delete All Connections Deletes all connections in the circuit. 

 Link PBs Links two or more push button switches 
together. 
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 Clear PB Links Disconnects any PB links in the circuit. 

 
Create Ladder Diagram Creates or edits a ladder diagram for electro-

hydraulic simulations. 

For more information on making connections see Chapter 5. 

3.7. SIMULATION MENU 

 

The Simulation menu contains the commands for simulating a pneumatic 
circuit, and individual components in HydraMotion. 

 
Circuit Selects the HydraMotion simulation feature. 

 
Simulation is available only when the Cross- Section 

display mode is active. 

 
Component Activates the simulation of a component. 

For more information on simulation modes see Chapter 7. 

3.8. INTERFACE MENU 

 

The interface menu contains the commands for online software operation. 

 Setup                  # Configures the hardware and software for online 
operation. 

 Display I/Os Provides graphic tracking of the inputs and outputs 
during online operation. 

 COM Test Tests communication between the hardware and 
software. 

For more information about on line operation, see Chapter 9. 
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3.9. WINDOW MENU 

 

The Window menu defines how the windows containing circuit diagrams are 
displayed on the screen. 

 
Open Main Window Opens a new main window. 

 
Close Main Window Closes the main window if it is open. 

 
Open 2nd Window Opens a new second window. 

 
Close 2nd Window Closes the second window, if it is open. 

 Cascade The usual Windows control for resizing and layering 
open windows so that each title bar is visible. 

 Tile The usual Windows control for resizing and arranging 
the open windows by size. 

 Arrange Icons The usual Windows control for realigning the icons of 
programs that have been minimized. 

 Close All Closes all open windows that are used for program 
editing. 

The Cascade or Tile setting remains in effect until changed. 
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3.10. HELP MENU 

 

The Help menu contains commands for viewing the software version information 
as well as the software licensing options.    

 About  Opens the About HydraMotion dialog box containing 
the current software version information.    

 Registration  Opens the License window enabling you to see your 
license status. 

In order to see the Registration dialog box, you need to 
run the application as an administrator. This enables 
you to perform various registration options, such as 
obtaining and retrieving your software license from 
Intelitek’s web site, e-mail, fax or phone. 
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 Components 
The Components menu allows you to select components and include text in your circuit diagrams. 

You can perform the following functions on components which have been placed in the drawing area: 
• Move • Rotate 

• Flip • Resize 

• Delete • Copy 

4.1. SELECTING COMPONENTS 

To view and place components in a circuit diagram, use either of the following: 

Component List dialog 

Components Library 

 The Component List 

 

Select Components | List or click the Component List button. The component list dialog box opens. 

 

 

To place components from the list into the drawing area, do the following: 

1. Select a category from the Groups list. 

(If you double click on one of the category names, the component library (graphic display) 

appears.) 

2. Select a components list. 
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3. Click OK. 

4. Click on the drawing area. The component appears at the point where you click on the drawing 

area. 

5. When you have finished placing the components in the drawing area, click Cancel. 

 The Component Library 

 

Select Components | Library, or click the Component Library button. 

The Components window opens. 

 

The components are shown either in cross section or as schematics depending upon the currently active 
display mode. 

You can move and resize the Components window, if necessary. You may need to use the horizontal 
scroll bar at the bottom of the window to find the component. 

To place components from the library into the drawing window do the following: 

1. Click on the picture of the component you want to use. 

2. Click on the drawing area. The component appears at the point where you click on the drawing 

area. 

The placement does not have to be exact; you can move components after you have placed 

them in the drawing area. 

3. When you are finished placing the components in the drawing area, click anywhere in the 

drawing area to close the Component Library. 
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4.2. MANIPULATING COMPONENTS 

Once you have placed components in the drawing area, you can manipulate and arrange them. 

To select a component, simply click on it. 

A frame with handles is drawn around the selected component. 

 

 

 Moving Components 

To move a component, do the following: 

1. Click on the component. A frame will be drawn around it. 

2. Click and drag the component to the desired location. 

 

 Rotating Components 

   

To rotate a component, do the following: 

1. Click on the component. A frame will be drawn around it. 

2. Select Edit | Rotate Right or Edit | Rotate Left. 

OR 

3. Select the Rotate Right, or Rotate Left button. 

4. The component is rotated 90° to the right or left. 
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 Flipping Components 

 

To flip a component, do the following: 

1. Click on the component. A frame appears around the component. 

2. Select Edit | Flip OR click on the Flip button. 

The component is flipped over. The top and bottom sides are reversed. 

 Mirroring Components 

 

To mirror a component, do the following: 

1. Click on the component. A frame appears around the component. 

2. Select Edit | Mirror OR click on the Mirror Button. 

The component is mirrored. The left and right sides are reversed. 

 Resizing Components 

To resize a component, do the following: 

1. Click on the component. A frame appears around the component. 

2. Place the mouse on one of the frame handles. 

The cursor changes to a double arrow. 

3. Click and drag the handle to readjust the size of the component. 

OR 

4. Use the + and - keys to resize the selected component. 

 Copying Components 

 

To copy a component in the circuit diagram, do the following: 

1. Click on the component. A frame appears around the component. 

2. Select Edit | Duplicate, or click the Duplicate button. 

A copy of the component appears on top of the original component. The duplicate component is now 
selected, and can be manipulated. 

You can orient, move, or resize the copied component as needed. 
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The File | Copy command places the selected component on the Windows clipboard. This allows you to 
be paste a component into another application as a graphic object. It does not make a copy of the 
component in the circuit diagram. 

 Deleting Components 

 

To delete a component, do the following: 

1. Select the component you want to delete. 

2. Select Edit | Delete, or click on the Delete Object button; you are prompted to confirm. 

 

3. Click Yes to delete the component. 

 Adding Text 

HydraMotion allows you to add text to your circuit drawings. To add text, do the following: 

1. Select either the Components List or the Components Library. 

2. Select the Text object, in the list or library. 

3. Place the text object anywhere in the drawing area. 

4. Close the list or library. 

5. Select the text object, if not already selected. 

6. To enter text in the Input Text dialog box do one of the following: 

▪ Press [Enter]. 

▪ Double click on the text object. 

7. Replace “TEXTO” with the text you want to appear in the circuit diagram. 

 

8. Click OK. 
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9. The text will be displayed in the drawing window. 

10. The text now appears as an object in the diagram. You can manipulate it in the same way as any 

component. Text cannot be flipped horizontally or vertically. 

4.3. COMPONENT PARAMETERS 

 Editing Component Parameters 

 

HydraMotion allows you to set values for a number of components. To set the component parameters 
do the following: 

1. Select the component whose parameters you want to view or change. 

2. Select Edit | Parameters, or click on the Component Parameters button, the Input Parameter 

dialog box opens. 

If more than one variable appears in the list, select the one you want to view or change. 

3. The current value of the selected variable is displayed. You can change this value by typing a new 

value, or by selecting a value by means of the scroll bar under the field. 

4. Click OK. 
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 Connections 
Components and devices are connected on the screen by means of colored lines which represent 
pneumatic and electrical connections. 

Once components are connected, they cannot be rotated, flipped, or resized; they can however, be 
moved or deleted. 

Deleting a connected component will also delete all lines connected to it. 

5.1. CONNECTING COMPONENTS 

 Making Pneumatic Connections 

 

To connect components do the following: 

1. Select Connections | Connect Components, or click the Connect Components button. 

A grid of dots appears in the drawing area, indicating that components can now be connected. In 

addition, black boxes with white borders appear at component ports where connections can be 

made. 

 

  

2. Point the mouse on an available port. The border turns green, indicating a connection can be 

made. 

3. Click the mouse, a blue arrow appears indicating the first port has been selected. 

Optional: you may route the connection between an inlet and an outlet by clicking the mouse to 

make right angle turns along the route. A red line will mark the path as you create it. You can use 

this option to route lines around a component. 
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4. Bring the cursor to the second port. The border turns green. 

5. Click the mouse, a light blue line now connects the two components. 

 

 Making Electro-Pneumatic Connections 

 

Connecting electronic components is similar to connecting the pneumatic components. 

To connect electronic components do the following: 

1. Select Connections | Connect Components, or click the Connect Components button. 

Electronic components have colored circles to indicate their sockets. Red sockets are live. Blue 

sockets are ground. 

On switches and relays, red sockets are normally closed, black sockets are normally open, and 

blue sockets are common. 

2. Point the mouse on the first socket, the socket turns green indicating a connection can be made. 

3. Click the mouse. A light blue arrow now appears, indicating a socket has been selected. 

4. Bring the mouse to the second socket. The socket turns green. 

The path will be indicated by an aqua line as you drag the mouse to the second port. 

Optional: you may route the connection between sockets. Click the mouse to make right angle 

turns along the path. Aqua-colored lines mark the path as you create it. You can use this option 

to route lines around a component. 

 

 

5. Click the mouse. The line turns red, indicating the connection has been made. 
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 Deleting one Connection 

To delete a connection do the following: 

1. Point the mouse on the line you want to delete. Do not click. The connection will blink and 

change color. 

2. Press [Del], the connection will be deleted. 

 Deleting All Connections 

 

To delete all of the connections do either of the following: 

• Select Connections | Delete All Connections. 
OR 

• Click on the Delete All Connections button. 

All connections are deleted. 

 Erasing an incomplete Connection 

To erase a partially complete connection, press [Del]. 

The line is deleted. 

 Changing the Second Port of a Connection 

To change an existing connection, do the following: 

1. Place the mouse on the line you want to delete. The connection will blink and change color. 

2. Click on the line you want to change. 

3. The line changes color. The second port is disconnected while the first port remains selected. 

4. Click on the port you want for the new connection. 

The new connection is displayed. 

 Exiting the Connections Window 

 

To exit the Connections window, do either of the following: 

• Click on the Close Connections button. 
 
OR 

• Press [Esc]. 

The dot grid disappears and you can perform other operations on you circuit diagram. 
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5.2. LINKING PUSH BUTTONS 

For safety reasons, a hydraulic circuit may require simultaneous (two handed) operation of two push 
buttons. Since you can only click one button at a time, the push button link option allows you to 
simulate simultaneous, two-handed, activation of the push buttons. 

Push button links can be made only when the Cross-Section display mode is active. These links cannot be 
made when the Connections or Schematic mode is active. The links can, however, be removed when any 
display mode is active. 

To link two push buttons, do the following: 

1. Select Connections | Link PBs. 

You are prompted to select the master push button. The master is the push button which 

controls both push buttons. 

2. Click on the PB that you want to serve as the master. 

The letter M is now displayed inside the component. 

You are prompted to select the slave push button. The slave is the push button which is 

controlled by the master. 

3. Click on the push button that you want to serve as the slave. 

The push buttons are now a linked pair, as indicated by an identical digit (e.g., M1 and S1) 

 

 

When you activate the master push button, the slave button is also activated. However, the slave push 
button remains operable on its own. 

 Disconnecting One Pair of Linked Push Buttons 

To disconnect the links between a selected pair of push buttons do the following: 

1. Select Connections | Link PBs. Lines appear showing all pairs of linked push buttons. 

2. Place the mouse on the line you want to delete. Do not click. 

3. Press [Del], the connection will be deleted. 

 Disconnecting All Push Button Links 

To disconnect the links between all push buttons select Connections | Clear PB links. 



 

5 Connections  

5.3 Ladder Diagrams 26 

 

All push button links are removed. 

5.3. LADDER DIAGRAMS 

 Creating a Ladder Diagram 

 

You can make electro-hydraulic connections by means of a ladder diagram. 

To create a ladder diagram, do either of the following: 

• Click on the Edit Ladder Diagram button. 
OR 

• Select Connections | Create ladder Diagram. The Create Ladder Diagram window opens. 

 

 

 Creating a Circuit from a Ladder Diagram 

The Create Ladder window has two parts. The top half shows the ladder diagram, the bottom half shows 
a table of electro-hydraulic components. (Components whose names appear in black have been placed in 

the drawing area and can be connected in a circuit). 

To connect components by means of the ladder diagram, do the following: 

1. Click on a black component in the table. 

The cell will turn white, and the cursor changes to a boxed +. 
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2. Click on the ladder diagram rung where you want to place the component. 

The component now appears in the ladder diagram 

Use the buttons at the top of the window to make, change or delete the connections. 

 

 
Checks the connections. 

If a connection or component turns red the connection is 
faulty. If nothing happens, the connection is OK. 

 
Even though the connections test is successful the actual 

components on the panel may not be properly connected. 

 
Connects Components. When selected, the cursor turns 
into a wand. 

Black lines indicate a connection. Click on the blue lines to 
turn them black (connect). 

 
Deletes components or connections. When selected, the 
cursor turns into a wire cutting tool.   

Place the cursor on the connection or component you want 
to delete, and click. 

 
Moves a rung in the ladder diagram down one line. When 
selected, the cursor turns into a shaded square. 

Place the cursor on the rung you want to move, and click. 
The rung moves down one line. 

 
Saves the connections made in the ladder diagram and 
exits to the main window. 

All connections make in the ladder diagram now appear in 
the circuit diagram. 

 Closes the Create Ladder Diagram window without saving 
the new connections. 

Any connections made in the ladder diagram will not 
appear in the circuit diagram. 
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 Views 
The View menu allows you to select the manner in which the components are displayed. Two basic 
display modes are available: 

• Cross-Section 

• Schematic 

The Zoom In and Zoom Out options can be used when either display mode is active. 

In addition, the view menu allows you to display two types of diagrams: 

• Ladder Diagram 

• Parameter Diagram 

6.1. CROSS SECTION DISPLAY 

The Cross-Section display mode provides a cross-section illustration of the components, as shown in the 
picture below.  The different colors allow you to see the different elements of each component. 

 

 

The cross-section allows you to observe the following: 

• Operation of the circuit and components. 

• Simulated hydraulic pressure flowing through the connections and its effect on the various 
components. 

• The component’s reactions to changes in pressure. 

 Activating the Cross-Section Display Mode 

 

To display the Cross-Section mode, do either of the following: 

• Select View | Cross-Section 
 

OR 

• Click on the Cross Section Button 

6.2. SCHEMATIC DISPLAY 

The Schematic option displays the components in standard schematic form, as shown in the picture 
below. This display mode is useful for observing and analyzing components in a pneumatic circuit or 
complex system. 
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The Schematic display mode is for viewing purposes only. Simulation or connections cannot be 
performed in this mode. 

 

 Activating the Schematic Display Mode 

 

To display the Schematic Mode, do either of the following: 

• Select View | Schematic 
 

OR 

• Click on the Cross-Section button 

 Zoom In 

 

To zoom in do the following: 

1. Select View | Zoom In, or Click on the Zoom in Picture button. 

The Choose Screen dialog box opens. 

 

2. A rectangle is attached to the cursor. Move the rectangle to select the part of the screen you 

want to enlarge, and click the mouse. 

 Zoom Out 

 

To Zoom out, do the following: 

• Select View | Zoom Out 

Selected 

 Zoom area 
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OR 

• Click on the Zoom Out Picture button.  

The circuit diagram returns to its normal view. 

6.3. PARAMETER DIAGRAM 

The parameter diagram monitors pressure and flow during circuit operation. The parameter diagram 
provides the user with a graphical view of pressure and flow in a hydraulic circuit. 

 

 

 Activating the Parameter Diagram 

 

To view the time diagram, do one of the following: 

• Select View | Parameter Diagram 
 

OR 

• Click on the Monitoring button 



 

6 Views  

6.4 Ladder Diagram Display 31 

 

6.4. LADDER DIAGRAM DISPLAY 

A ladder diagram is a schematic control flow chart for electro-hydraulic circuits. It is automatically 
generated by the software according to electrical connections you make in the diagram. 

 Displaying the Ladder Diagram 

 

  

To display the ladder diagram of the circuit diagram in the currently active window, do either of the 
following: 

• Select View | Ladder Diagram 
OR 

• Click on the Display Ladder Diagram button.  The Ladder Diagram window opens. 

 

 

 Closing the Ladder Diagram 

 

To close the ladder diagram, click on the Exit Ladder Diagram button, or use any standard Windows 
method for closing a window. 
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 Simulation 
The simulation mode allows you to observe the operation of a component working independently or as 
part of a whole circuit. 

Simulation is available only when the Cross-Section display mode is in effect. 

7.1. SINGLE COMPONENT SIMULATION 

You can simulate the operation of a single component in four ways: 

• Automatic step by step. This simulation displays continuously changing states of the selected 
component. 

• Automatic continuous. This simulation will show continuous operation of the selected 
component. 

• Manual step by step. This simulation shows each state of the selected component one at a 
time. You must continuously click the component to display each state. 

• Manual continuous. This simulation will show the continuous operation of the selected 
component. You must continuously click the component to make the simulation progress.  

The automatic continuous and manual continuous options are not available for all components. 

 Simulating a Component Automatically 

 
To automatically simulate a single component, do the following: 

1. Select the component you want to simulate. 

2. Select Simulation | Component and then select one of the two 

automatic simulation modes. 

Clicking the tool bar button activates the Single Component simulation Auto 
Stepped mode. 

 Simulating a Component Manually 

To manually simulate a single component, do the following: 

1. Select the component. 

2. Select Simulation | Component and then select one of the two manual simulation modes. 

3. Click on component to change the state or progress of the component. 

 Stopping the Simulation of Single Components 

 
Exit the simulation mode to make changes in the circuit diagram. 

To stop the component simulation, click on Exit from Single Component Simulation 
button. 

The normal viewing mode is resumed. 
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7.2. CIRCUIT SIMULATION 

 
HydraMotion allows you to simulate the operation of an entire circuit. 

To view the simulation of an entire circuit, do one of the following: 

• Select Simulation | Circuit. 
 
OR 

• Click on the Simulate Circuit button. 

Once you are in the simulation mode, you can click on any push button that is in 
the diagram to see how they will affect the hydraulic circuit. 

 Stopping the Circuit Simulation 

 To stop the circuit simulation, click on the Exit from Simulate Circuit 
button. 

The normal viewing mode is resumed. 
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 File Management 
HydraMotion files are managed through the standard Windows file tools, found in the File menu. 

 

 New           [Ctrl]+N Opens a new, untitled file.  

 

 
Open       [Ctrl]+O Opens a dialog box for selecting an existing circuit 

diagram file. 

 
Save          [Ctrl]+S Saves the currently active file. 

If the file is untitled, a dialog box opens for defining the 
file name. By default the system provides a file name 
(e.g., HY0012.BIN). You may give the file any title you 
want. The file name must contain only English 
characters or numerals. 
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 Save As Saves the currently active file under a new file name.  

The Save File dialog box opens. Enter a new name in 
the Title field. By default the system provides a file 
name (e.g., HY0012.BIN). 

 
Print           [Ctrl]+P Prints the currently active file. 

 

 Delete... Opens a dialog box with a list of previously saved files. 

Choose a file that you want to delete and click OK. 

 

. 

 

 Exit Quits HydraMotion. 

If changes have been made to a file, but not yet saved, 
a warning message is displayed. 
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 System Setup 

9.1. PROGRAM WINDOWS 

The Window menu contains Windows commands for the display of the program windows. 

 
Open Main Window Opens a new main window. 

This command functions the same as File | New. 

 
Close Main Window Closes the active main window. If changes have been 

made, but not yet saved, a warning message will be 
displayed. 

The button toggles between open and close. It opens a 
window if one is not currently active, and closes a window 
if one is currently active. 

 
Open 2nd Window Opens a new second window. 

The second window will open under the main window. It 
functions in the same way as the main window. It can be 
moved and resized. 

Only the main and 2nd windows can be open at the same 
time in HydraMotion. 

 
Close 2nd Window Closes the active second window. If changes have been 

made, but not yet saved, a warning message will be 
displayed. 

The button toggles between open and close. It opens a 
window if one is not currently active, and closes a window 
if one is currently active. 

 Cascade The usual Windows control for resizing and layering open 
windows so that each bar is visible. 

 Tile The usual Windows control for resizing and arranging the 
open windows by size. 

 Arrange Icons The usual windows control for realigning the icons of 
programs that have been minimized. 

 Close All Closes all open windows that are used for program editing. 

The Cascade or Tile setting remains in effect until changed. 

9.2. ON-LINE OPERATION 

HydraMotion can be used to control actual electro-pneumatic circuits and to provide graphic tracking of 
the HydraFlex laboratory panels. 

The CIC Unit (PLC Micrologix) is required for the software-hardware interface. Refer to the 
documentation provided with the panel and the CIC Unit (PLC MicroLogix) for installation instructions. 
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For information on how to configure the PneuMotion software when working in online operation, see: 

• Configuring the Software for Online Operation (PLC MicroLogix) 

 Configuring the Software for Online Operation (PLC MicroLogix) 

To configure the software for on-line operation, do the following: 

1. Make sure the computer, the panel; the PLC Micrologix and the power supply are all properly 

connected, as shown in the example below. 

 

1 PLC MicroLogix  

2 PLC to Power Supply 
Cable 

3 Power Supply 
Connections 

4 Power Supply Cables 
(Red and Black) to 
Electrical Distributer 

5 Electrical Distributer  

6  Double Acting Cylinder 
with Magnetic Sensors 

7 4/3 Sol-sol Control 
Valve  

8 Inductive Proximity 

PLC MicroLogix Connected to Power Supply and Panel  

2. Use HydraMotion to load or draw an electro-hydraulic circuit, which is (or will be) assembled on 

the HydraFlex panel. 

The figures below show an example of the same circuit drawn in HydraMotion and when set up 

on the HydraFlex panel. 

 

 

 

3 

5

 

7 

6

 

4

1 

4

2 

8 
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3. Select Interface | Setup. The Setup dialog box opens. This box allows you to select the 

components that are controlled and tracked by the software. 

 

All electrical input and output connections made in the circuit diagram are available in the Setup 

dialog box. 

4. Using the check boxes, select the components which will operate online.  

Once components are selected online operation, they respond to external I/O signals only. 

HydraMotion graphically tracks the operation of these components (and does not simulate their 

operation). 
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5. Click the Controller Configuration button to connect the HydraMotion software to the PLC 

MicroLogix. The following configuration window is displayed. 

 

6. From the Comm Port drop down list, select the required COM port and click Apply.   

7. Click Close. A confirmation message is displayed.  

8. Click Yes. A message is displayed requesting you to restart your application. Click OK.  

9. Restart the HydraMotion application. 

10. Select Interface | COM Test to communicate with the controller. One of the following options 

will appear on the status bar on the bottom right hand corner of the window:  

▪ : Indicates the HydraMotion is communicating with the PLC MicroLogix controller.  

▪ : Indicates no communication exists between the HydraMotion software and the 

controller. In this case check your controller configuration.              

 


